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1 BEFORE YOU START

Congratulations on your investment in Topaz Enhance! When used correctly this set of video
enhancement plug-ins will dramatically increase the quality of your videos.

The best way to learn how to harness the powerful set of tools in Topaz Enhance is to try out
different filters and settings! Spend a few minutes, play with it, and don’t hesitate to contact us if
you have any questions.

Chapter 1 (this chapter) describes some essentials specific to different host programs that must
be observed when using Topaz Enhance. Please read this chapter carefully or the filters may
not work as they’re intended to.

Chapter 2 serves as a reference guide for each Topaz Enhance filter. It describes the functions of
each filter and details the purpose and usage tips of each parameter.

If you’d like more information, visit http://www.topazlabs.com for tutorials, tips, example
projects and other resources. Please check this site often for new tutorials and software updates.

As always, email us at support@topazlabs.com if you have any questions, comments, or
suggestions. We would love to hear from you!
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Before You Start

Memory and Cache Usage Preferences Requirement

Before using Topaz Enhance, go to your Preferences Menu. On a Mac, that’s in After Effects ->
Preferences; on Window’s it’s in Edit -> Preferences. Select the Memory & Cache tab.

The window can be seen here.

Preferences

Now, make sure that the sum of

your Maximum Memory Usage e . ok )

and the Maximum RAM Cache Maximum Memory Usage: | 35 | % = 1.0 GB (" cCancel )

Size settings are not greater than Image Cache JE—

Previous

1.5 GB. Maximum RAM Cache Size: | 19| % = 458 MB /:
") Enable Disk Cache et

Adjust the percentages until both Maximum Disk Cache Size: 2000 MB

numbers added together are less

than 1.5 GB, as shown in the

menu to the right. Your
Conformed Media Cache
£ GChoose'Eoldar==a

percentages might be different

depending on hOW much memory Database: [ Choose Folder...
you have, but make sure the

absolute values, added up, are less Cache: {_Choose Folder...
than 1.5 GB. You will, however,

/Users/eric/Library/Appii...upport/Adobe/Common/

/Users/eric/Library/Cach...Adobe/After Effects CS3/

( Clean Database & Cache

want the Maximum Memory
Usage to be greater than the
Maximum RAM Cache.

If this isn’t done, your host

program might crash
unexpectedly at times.

Two Types of Filters

There are two types of filters in Topaz Enhance:

w7 Topaz Enhance

1. Single-frame filters (also called “intra-
frame” filters) use only the current video
frame to compute the result. Single-
frame filters lack a “*” in their name.

For example, Sharpen Edges (RGB) is a
single-frame filter.

2. Multi-frame filters (also called “inter-
frame” filters) use the current video

List of multi-

1@ Clean (RGB)* and single-
8 Clean (YO)* frame filters
8 Deinterlace*

8 Denoise & Enhance*

z@ Double Resolution*®

8 Enlarge*

2 Remove Compression Artifacts
-8 Sharpen Edges (RGB)

@ Sharpen, Fix Color Bleeding
=8 Sharpen, Line Accent

28 Wavelet Filter
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frame and several frames before and after the current frame to compute the output
frame. Multi-frame filters are indicated by the suffix “*” in their name, e.g.,
Deinterlace*.

Multi-frame filters will usually offer more quality while single-frame filters offer more speed.

Another difference is that single-frame filters can be used in interlaced sequences where multi-
frame filters only work on progressive sequences. More on that in Chapter 2.

Three Types of Parameters

Filters in Topaz Enhance have three types

of parameters: PS. d : ontro B E a

* Required (!!!) parameters, € ntscClips.avi 4\
which must be set correctly or Diinteceips v — — .
. F Remoye Compre... ese out...
the filter will not work properly. §+¥ 7 Temove Hompre.. . nme e =}
propetly Animation Presets [ None |4
* Main parameters, which have > & W Frame type =
major effects on the outcome. b ©] Suppression -
P> Advanced
* Advanced parameters fine-tune < [# Deinterlace® About..
the effects of the filter. Great for Animation Presets / None |4
experienced users who like hlgh + &) W Field Order Vv Lower field first
levels of control over their b & Threshold 200 A
P> Advanced
results.

Required parameters are indicated by the prefix “!!!”. Make sure to set these properly, as
sometimes the default value is irrelevant and doesn’t work at all.

Topaz Enhance filters have many parameters but you can safely ignore the Advanced settings
and use their defaults when you’re just starting out.

De-interlace videos first!

We highly recommend that videos be de-interlaced prior to processing using any other
Topaz Enhance filter.

7 ¢ Deinterlace* &
¥ 11l FootageF...29.970
111 Field Order [¢] Lower fieldfi...

P ) Threshold  5.00
' ADVANCED

If a video is interlaced, use Topaz Deinterlace* or Topaz Enlarge* to de-interlace it before
processing with any other filter. Although Topaz Enhance filters still work on interlaced footage,
you will get best results when using it on progressive or de-interlaced footage.
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Adobe Premiere with Topaz Enhance

A few quick issues that are specific to Adobe Premiere. This section is applicable to Windows
users only.

Use progressive projects and sequences when working with Topaz Enhance,
even when footage is interlaced.

In order for Topaz Enhance to achieve its full potential, it needs to use many frames of
the video to process its result. Because of this, we recommend that all Topaz Enhance
functions be done in a progressive project separate from your main project. This way you
can enhance the quality of either your entire video or little bits of footage without interfering
with your original movie project file.

+| HDV 720p25

o] HDV 720p30 Video Se;tings
“ Mobi . Frame size: 1280h 720v (1.000)
(1] Mobie & Devices Frame rate: 29.97 frames/second

Pixel Aspect Ratio: Square Pixels (1.0
Fields: No Fields (Progressive Scan

Set this option when creating your project. To do this, create a new project and make sure
“Fields” is set to No Fields (Progressive Scan) before you start working.

Note: single-frame filters can still be used in interlaced projects. For purposes of
simplicity, however, we still recommend that you use a separate progressive project for all Topaz
Enhance functions.

Match the frame rates of your sequence and your footage.

In Premiere it is important that the frame rate of both the sequence and the footage
be exactly the same. For example, if the frame rate of the footage is 29.97, the sequence should
be exactly 29.97 as well — not 29.95 or 30.

E4) dvd_nasa_filmmodeavi (] 29.97fps
T scalex [] 29.97 fps

To change the frame rate of the project, create a new project and either enter the correct frame
rate in Custom Settings or choose a preset in Load Preset.
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Disable all frame interpretation.

Before you put the footage into a composition, select it and go to Clip->Video Options-
>Field Options to make sure it’s set to “None”. Then go to Clip->Video Options and uncheck
“Frame Blend”.

Videe Opticons » Frame Hold...
Audio Options » Field Options...
Speed/Duration... Ctrl+R EameBiend

Scale to Frame Size

Set the video quality to “Highest Quality”.

Click the Output icon with three overlapping circles and choose “Highest Quality”. This
button is underneath your preview window next to the playback controls:

_ e
ITEREEWTT

Some filters may appear as if they had no effect if the quality isn’t set to “Highest Quality”.
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Adobe After Effects with Topaz Enhance

A few quick issues that are specific to After Effects. This section is applicable to both Intel-
based Mac and Windows users.

A multi-frame filter must always be the first filter in a composition.

Multi-frame filters use multiple frames on either side of the selected frame to process its
result. They are distinguished by a “*” suffix, i.e. Deinterlace* and Enlarge*. Single-frame filters
use and process only the present frame. They lack a “*” suffix, i.e. Sharpen Edges (RGB).

In After Effects, multi-frame filters
will only work if they are at the top of the
effects stack in that particular composition.
So, if you want to apply a multi-frame filter
like Enlarge* to your composition, put it on
top of the effects stack or it won’t work.
Single-frame filters will work regardless of
their position.

F ntscClips.avi - Effect Controls

B>

P &/ Suppression
P Advanced

What if you want to apply two multi- v f Dfi“*f”“e*
Animation Presets

frame filters, like Deinterlace® and Denoise T
and Enhance*? In this case, you have to nest b & Threshold
your compositions, meaning that you place the b Advanced
current composition into a new composition.
You then apply the second multi-frame filter to
the new composition — this way both multi-
frame filters are on top of the effects stack for
both compositions. You can also use the
Precompose feature to do this.

| MNone
400
150

P Advanced - v

For example, say you have DV footage and you want to first deinterlace it, remove codec
blockiness, and finally remove all the noise and clean it up. We will use Deinterlace*, Remove
Compression Artifacts, and Denoise and Enhance*. Unfortunately you cannot just use all three
filters in the same composition, because Deinterlace* and Denoise and Enhance* will not work
correctly since they won’t be the first filter.

What you would do in this situation is create two compositions, say, compl and comp2. Put the
video footage in compl and apply Deinterlace* and Remove Compression Artifacts to it.
(Remember, because Remove Compression Artifacts is a single-frame filter you can put it
wherever you want.) Then, drag and drop comp1 into comp2 and apply Denoise and Enhance*.
Both multi-frame filters will be happy and work correctly because they are both at the top of the
effects stack in their respective compositions.

10
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Set the video quality to “High”.
Topaz Enhance requires complete video frame data in order to achieve best results.
Therefore, you need to set Video Quality to High on your clips. Some filters might appear to

have no effect if this isn’t done.

To set video quality to high:

1. In Timeline window, look for [Elcomp 1 4\

the little diagonal line to the 0:00;02;20 (29.97 fps) By S I M
right of your video name. FOOE % #  SowceName SN FEMOE Paret
) PO 1 " tepvav & (/)1 b None xt

2. Make sure the diagonal line is
solid and not dotted. If it isn’t,
click on it once and it should
change to become solid.

Be careful when changing frame rates.

Be cautious of changing frame rates when using Topaz Enhance. During video enhancement,
we recommend that your composition/output video always have the same frame rate, or exactly
double the frame rate of the input video for interlaced videos. You can change the rate in later
stages of post-production, but try not to in the enhancement stage.

This is because inter-frame filters analyze motion in multiple frames of the video to achieve a
result that is not possible to achieve by using only one frame. However, they generally require
smooth motion among frames. When you change frame rate, e.g.,from NTSC 30fps to PAL
251ps, the original smooth motion will not be present in the resulting video.

11
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2 VIDEO TUTORIALS

The quickest way to learn how to use Topaz Enhance is to take a look at our
collection of video tutorials designed to help you hit the ground running. They
cover a selection of topics from SD to HD upconversion to low light noise
reduction and will visually walk you through each step. They contain the project
file and the before and after videos so you can reproduce the steps as you’re
following each video.

Even if the tutorial doesn’t use your host program, you can still follow along
because the operation is very similar across each host program. Just ignore the
program-specific parts and instead look at the filter usage.

More video tutorials will be added regularly.

They are at the Topaz Enhance website under “Featured Tutorials here:

http://www.topazlabs.com/topazlabs/03products/topaz enhance/

12
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3

FILTER DESCRIPTION

This chapter provides detailed description for each filter in Topaz Enhance.

Topaz Enhance uses the following conventions:

e  Suffix “*”: A filter whose name has suffix *, e.g., “Clean (RGB)*” and “Deinterlace*”,
uses multiple frames around current frame. This type of filter must be the first filter applied to
footage. If you need to apply a filter in front of it, you must nest that composition within
another (or use the pre-compose feature)

¢ Prefix “!!!”: If a filter parameter has “!!!” as prefix, this is a required parameter. Be sure to
set it correctly.

* Non-After Effects Host: a few filters will have additional parameters appears on host other
than After Effects. We will have a separate table to describe these parameters.

Main parameters and Advanced parameters will be listed in separate tables. The default
values for the advanced parameters generally provide reasonable result. Therefore, new users of
Topaz Enhance may use the default values at the beginning.

You generally need to set the Required parameters and Main parameters.

13
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Clean (RGB)*

Io ntscClips.a¥i 4\

DI * ntscClips.avi

v |f Reset About..
P & Threshold 4.0
= Advanced
P & Radius 4.00
+ O Use frames
» & Iterations =]
+ &) De-speckles Enabled
b &/ G ch. Threshold Adj.  1.00
[» &| B ch. Threshold Adj.  1.00

Clean (RGB)* uses a unique algorithm to preserve features and filter noise. It combines
noise reduction with edge optimization, and uses neighboring frames for effective
discernment of noise and edges. This ensures that relevant details are left as intact as
possible while the noise is suppressed. However, due to the intensive processing,
Topaz Clean is the slowest of all the Topaz Enhance filters.

Clean (RGB)* operates on image in the RGB channels of your video. Compared with
Clean (YC)*, this filter is best suited for video with no color sub-sampling (4:4:4).
You should observe the following in order to use this filter to its best result:

* The filter performs best in progressive videos. If you have interlaced video
footage such as from NTSC or PAL DV video, we highly recommend that you de-
interlace it first using Topaz Enhance’s Deinterlace*.

* With that in mind, this filter still works for interlaced videos. If you do not want to
de-interlace the video, it is best to still turn Interpret Fields off to process video in
frame mode. Then use the result as interlaced video.

This filter has only one main parameter that needs to be set properly.

Clean (RGB) - *Main Parameters

Main Parameters Description

Threshold Sets the threshold on what is considered as noise. This value affects all R,
G, and B channel noise threshold. The R channel uses this value directly
while G and B can be adjusted relative this value in Advanced setting.

14



Topaz Enhance V2.3 User’s Manual

Filter Description

A higher setting will suppress more noise but can also suppress details.

Tips: When the threshold is too small for the current noise level, the filter
has little effect. Try to increase the threshold until the noise is obviously
reduced. Then gradually reduce it so that more details are preserved.

These advanced settings are for experienced users to fine-tune the effects of the filter:

Clean (RGB)* - Advanced Parameters

Advanced Params

Description

Radius

Sets the “size” of the neighboring pixels that affect the cleaning operation.
A greater value will make use of more nearby pixels and make the frame
cleaner.

All RGB channels use this value.

Tip: a smaller value results in faster processing but less cleaning.

User frames

Selects number of frames around the current frame used in the
processing. Choose a number greater than 1 if you video noise is high.
This allows the filter to better discern between details and noise.

Tip: For highest quality processing set this to the maximum value unless
there is a large discrepancy in the frames like a scene switch.

Iterations Sets the number of passes that are run. Use the default value 1 in most
situations.
Tip: To clean up an extremely noisy frame, using multiple iterations may
achieve better results than just increasing the threshold.

De-speckles Choose this option if you observe excess random speckles in the form of

black or white dots.

G ch. Threshold Adj.

Sets the value of G (green) channel threshold relative to the main
Threshold.

For example, if Threshold=3.0 and this value is set to 1.5, the threshold
for G (green) channel will be 3.0x1.5=4.5.

B ch. Threshold Adij.

Sets the value of B (blue) channel threshold relative to the main
Threshold.

For example, if Threshold=3.0 and this value is set to 1.5, the threshold
for B (blue) channel will be 3.0x1.5=4.5.

Tip: Some cameras produce more noise in the Blue channel in low lighting
situations. You can examine the noise in each channel by only displaying

15
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that channel and then adjusting the B/G ch. Threshold.
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Clean (YC)*

JG ntscClips.avi J\

Filter Description

DI # ntscClips.avi

¥ Bl Clean (YC)¥

P & Threshold
= Advanced
P & Radius
+ &) Use frames
+ O/ Iterations
+ O De-speckles
P & C Threshold Adj.
P &| C Radius Adj.
+ &) Preview Mode

-]

Enabled

Final RGB s

Clean (YC)* combines effective noise reduction with edge optimization. Much like Clean
(RGB)*, it uses neighboring frames for effective discernment of noise and edges. Clean
(YC) allows you to clean up both the luminance (Y) and color (Cb, Cr) of your frame.

In addition, Clean (YC)* reduces color bleeding and recovers color edges. Therefore, it
should be used to clean videos coded with YCbCr, YUV, or YIQ color space, with color
sub-sampling such as 4:1:1, or 4:2:0. MiniDV, Motion JPEG, MPEG-I/Il and many other

videos are included in this category.

For best results, note the following:

* The filter performs best for progressive videos. If you have interlaced video
footage such as from NTSC or PAL DV videos, we highly recommend you de-
interlace it first using Deinterlace* filter in Topaz Enhance.

* With that in mind, this filter still works for interlaced videos. If you do not want to
de-interlace the video, it is best to still turn Interpret Fields off to process video in
frame mode. Then use the result as interlaced video.

This filter has only one main parameter that needs to be set properly.

Clean (YC)* - Main Parameters

Main Parameters

Description

Threshold

Sets the threshold on what is considered as noise. This value affects all R,
G, and B channel noise threshold. The R channel uses this value directly

17
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while G and B can be adjusted relative this value in Advanced setting.
A higher setting will suppress more noise but can also suppress details.
Tips: When the threshold is too small for the current noise level, the filter

has little effect. Try to increase the threshold until the noise is obviously
reduced. Then gradually reduce it so that more details are preserved.

These advanced settings are for experienced users to fine-tune the effects of the filter.

18

Clean (YC)* - Advanced Parameters

Advanced Params

Description

Radius

Sets the “size” of the neighboring pixels that affect the cleaning operation.
A greater value will make use of more nearby pixels and make the frame
cleaner.

All RGB channels use this value.

Tip: a smaller value results in faster processing but less cleaning.

User frames

Selects number of frames around the current frame used in the
processing. Choose a number greater than 1 if you video noise is high.
This allows the filter to better discern between details and noise.

Tip: For highest quality processing set this to the maximum value unless
there is a large discrepancy in the frames like a scene switch.

Iterations

Sets the number of passes that are run. Use the default value 1 in most
situations.

Tip: To clean up an extremely noisy frame, using multiple iterations may
achieve better results than just increasing the threshold.

De-speckles

Choose this option if you observe excess random speckles in the form of
black or white dots.

C Threshold Adj.

Set the noise threshold of Cb and Cr channel relative to Threshold.

For example, if this value is set to 1.5, then the threshold for Cb and Cr
channels is 1.5 times greater than the threshold of Y.

Tip: Increasing this value can reduce color noise and color bleeding.

C Radius Ad;.

Set the radius for Cb and Cr channel relative to the radius of Y.

For example, if this value is set to 1.5, then the radius used to process Cb
and Cr channel will be 1.5 times of Y.
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Tip: Increasing this value can reduce color noise and color bleeding.

Display

Select output image pre-view:

* Final RGB allows you to view your enhanced frame in normal
RGB. What you see here is what you get after final rendering. Yo
must use this mode when rendering for final output.

u

* Processed YC lets you display YCbCr in place of RGB to observe

the processed result. You can use it to examine the Y, Cb, or Cr
channels (select R for Y, G for Cb, or B for Cr channel to display)
and determine the result of color channel noise suppression,
especially how well color bleeding is corrected.

* Original YC displays the unprocessed frame in YCbCr format.

19
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|ﬂntscClips.avi N

Filter Description

DI # ntscClips.avi

= f Deinterlace® Reset About...
» &) ! Field Order

P & Threshold 5.00
= Advanced
P &/ Motion Candidates 3
P &/ Spatial-Temporal Balance  0.50
P & C Channel Weight 1.00

Deinterlace* in Topaz Enhance uses temporal analysis techniques to de-interlace

videos with high-quality results.

This filter has two main parameters that need to be set properly.

Main Parameters of Deinterlace*

Main Parameters

Description

! Field Order

This must be set properly according to the footage field order. An
improper value will lead to poor de-interlacing and jerky motion.

Tip: NTSC videos are usually Lower Fields first, PAL is usually not.
However, there are exceptions, so just try out both options and see which
one looks the best.

Threshold

Specifies the threshold for change detection.

A high value enables the filters to tolerate more variation among
neighboring fields that are used to synthesize the high resolution.
However, an excessive value may lead to incorrect change detection and
jagged edges.

A low value reduces the tolerance of variation. Too low of a value may
result in intra-fields interpolation which will give a lower resolution result.

Tip: Use high values, 6~12, when videos are noisy. Use lower values,
4~8, for relatively clean videos.

20
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Experienced users may further tweak the filter using the following parameters.

Advanced Parameters of Deinterlace*

Advanced Params

Description

Motion Candidates

Specifies number of candidate motion vectors that are considered for each
pixel in synthesizing the frame.

Tips: 2~3 is usually good for most situations. Higher values increase
processing time.

Spatial-Temporal
Balance

Sets the balance between spatial processing and temporal processing.

Deinterlace™ tracks and compensates for object motion in the video to
obtains its result. When it senses scene changes or fails to reliably track
the motion, it falls back to field interpolation. This value determines the
balance between spatial and temporal processing.

Tips: 0.5~0.8 usually works for most situation. If no jagged edges result,
higher value tends to give better result.

Non-After Effects Hosts

For hosts other than After Effects, an extra parameter must be set correctly.

Deinterlace* - Additional Parameters for non-AE hosts

Parameter

Description

1! Footage frame
rate

You must enter the exact frame rate of the footage.

For example, if the footage is a NTSC DV with 29.97 FPS, you must enter
29.97 (not 30 or 29.95) in order for Deinterlace* to achieve optimal
results.

21
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Denoise & Enhance*

Jo ntscClips.avi -I\

DI * ntscClips.avi

v |f Reset About...
P &| Threshold 6.00
P &| Sharpness 150
= Advanced
> & Filtering Strength 2
P> & Spatial-Temporal Balance 063
P &/ Original Pixel ¥Weight 0.06
P &/ € Channel YWeight 1.00

The Denoise & Enhance”* filter uses up to seven frames around the current one to filter
noise and enhance clarity and details. Moving scenes in video are motion-compensated
on a pixel-by-pixel basis to achieve the best result. Upon detecting a scene change or
large motion, the filter will use intra-frame filtering instead.

The Denoise & Enhance* filter is very effective in simultaneously suppressing small to
medium levels of noise and revealing the hidden details. For severe noise, you may
need to use it together with the Wavelet* filter in Topaz Enhance. As an alternative,
you may also try Clean (RGB)* or Clean (YC)*.

Here are some hints on when to use this filter

* Work with progressive videos for the best result. Use Deinterlace* to de-
interlace video first for interlaced video.

* Denoise & Enhance* enhances the clarity of video and creates a natural result.
It is the preferred filter for noise reduction and clarity enhancement. Clean
(RGB/YC)* can create sharp edges and reduce color bleeding while reduce video
noise. However, sometimes it may create jagged edges and suppress some

details as well. Try them out for your particular situation and select the result you
want.

* Denoise & Enhance* filter assumes the video motion is smooth across each
frame while Clean (RGB/YC)* do not. Therefore, Denoise & Enhance* will not
work well for cartoons or some slow-mo videos where the objects move every
few frames. Use Clean (RGB/YC)* instead.

This filter has two main parameters that need to be set properly.

22
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Denoise & Enhance* - Main Parameters

Main Parameters Description

Threshold Specifies the threshold for noise suppression.

A high value enables the filters to tolerate more variation among
neighboring frames and filter out more noise.

Tip: Use a high value, 6~12, when the video is noisy. Use a lower value,
4~8, for clean video.

Sharpness This value specifies the strength of details and sharpness enhancement.

Tip: increase this value to bring out more details. However, do not over-
use it or it will cause overshooting or ringing edges.

Experienced users may further tweak the filter using the following parameters.

Denoise & Enhance* - Advanced Parameters

Advanced Params Description

Filter Strength Sets the value of the maximum noise filtering strength. Higher values
result in better noise suppression.

Tip: use 3~4 for strong noise, 2~3 for light noise, and 2 for details

enhancement.
Spatial-Temporal Sets the balance between spatial (intra-frame) processing and temporal
Balance (inter-frame) filtering.

Denoise & Enhance* tracks and compensates for object motion in the
video to suppress noise and enhance details. When it senses scene
changes or fails to track large motion, it falls back to intra-frame filtering.
This value determines the balance between spatial and temporal filtering.

Tip: 0.5~0.8 usually works for most situations. If no jagged or blurred
edge result, try to use a higher value so that more inter-frame processing
is used.

Original Pixel Weight | Set the minimum weight for the unfiltered pixel value to be added in the
processing.

Tip: normally the minimum value works best. Use a high value if you want
some of the noise and details to seep into the result to make it look more
natural.

C Channel Weight The color channels Cb and Cr are used in the motion tracking calculation.
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This value specifies the weight of the color channels against the luminance
channel Y.

Tip: set this value to 0 to disable C channel calculation and increase
processing speed. However, watch out for situations where color changes
but luminance does not, which will lead to color bleeding artifacts.
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Double Resolution*

Jo ntscClips.avi —l\

DI * ntscClips.avi

< f Double Resolution* Reset About..
P &) Threshold 4.00
P &) Sharpness 150
= Advanced
P &) Motion Candidates 2

P> &/ Spatial-Temporal Balance 063

NOTE: This filter is replaced by the Topaz Enlarge* filter since v2.2. To increase
resolution, use the Enlarge* filter instead, which is faster, more effective, and
easier to use.

The Double Resolution* filter doubles video resolution and produces a video exactly
twice number of pixels both horizontally and vertically. It uses a super-resolution based
method that use multiple frames to synthesize a high-resolution video.

You need to set the width and height of the composition approximately twice the size of
the footage to accommodate the enlarged video.

Using Double Resolution* is straightforward. However, you need to observe the
followings to achieve best result:

* Work with progressive video for the best result. Use Deinterlace* to de-interlace
video first for interlaced video.

* Double Resolution* assumes the video motion is smooth across each frame.
Therefore, the filter will not work well for carton or slow-mo type of video, where
the objects in video move every a few frames.

This filter has only two main parameters that need to be set properly.

Main Parameters of Double Resolution*

Main Parameters Description

Threshold Specifies the threshold for change detection.

A high value enables the filters to tolerant more variation among
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neighboring frames that are used to synthesize the high-resolution frame.
However, high value may also lead to wrong detection of scene change
and leads to jagged edges.

A low value reduce the tolerant of variation, which may result in little inter-
frame inform being used. Too small value tends to result intra-frame
interpolation, which will give lower resolution result.

Tips: Use high value, 8~15, when video are noisy. Use lower value, 6~10,
for clean video.

Sharpness

This value specifies the strength of details and sharpness enhancement.

Tips: increase this value to bring out more details. However, do not over
use it to cause overshooting or ringing edges. Use Sharpen Edge filter if
you want further increase sharpness.

Experienced users may further tweak the filter using the following parameters.
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Advanced Parameters of Double Resolution*

Advanced Params

Description

Motion Candidates

Specify number of candidate motion vectors, for each pixel, to be
considered in synthesizing high-resolution frame.

Tips: 2~3 is usually good for most situations. Larger number increase
processing time.

Spatial-Temporal
Balance

Set the balance between spatial (intra-frame) interpolation and temporal
(intra-frame) processing.

Double Resolution* tracks object motion in the video and compensates
the motion to obtains its result. When it detects sense change or fails to
reliably track large motion, it fails back to frame interpolation. This value
determines the balance between spatial and temporal processing.

Tips: 0.5~0.8 usually works for most situation. If no jagged edge result,
try to use higher value so that more processing is used.
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Enlarge*

_IO chicken.wmy -l\

Comp 1 * chicken.wnv

< f Enlarge¥®

M Video Type

P & 2oom in

P &/ Threshold

P & Sharpness

= ADVANCED
P & Luma Moise Reduction
P &| Temporal Processing

P & Color Noise Filtering 1

P> & Height Adjustment 1.00

P &/ Add Grain 200
= DEINTERLACE

P &) Threshold 4.00

P &| Temporal Processing 063

The Enlarge* filter is a combo filter that achieves the following functions in one easy-to-
use filter:

3.

4.

De-interlace if the footage is interlaced.

Increase video resolution, i.e. up-convert video, up to 4 times of the original using
super-resolution technology.

Reduce both luminance and color noise.

Sharpen edges.

If you want to enlarge, or scale up, a video clip, try this filter first before using other
filters. This filter is much easier to use and renders much faster. In most cases it
produces excellent results, although it fails with some video types. If you find that Topaz
Enlarge* has a minimal effect, try using a combination of the other dedicated filters in
Topaz Enhance.

Using Enlarge* is straightforward. However, please note that Enlarge* assumes the
video motion is smooth across each frame. Therefore, the filter will not work well for
cartoons or slow-mo videos, where the objects in video move every a few frames.
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This filter has four main parameters that need to be set properly:

Main Parameters of Enlarge*

Main Parameters

Description

1! Video Type

This must be set properly according to the footage type. If your footage is
not interlaced, set this to “Progressive”. If the footage is interlaced, set this
as either “lower field first” or “higher field first”, depending on the video.

Tip: NTSC videos are usually Lower Fields first, PAL is usually not.
However, there are exceptions, so just try out both options and see which
one looks the best.

Zoom in

The up-scaling factor, ranging from 1.2X to 4X of the original video size

Threshold

Specifies the threshold for both change detection and noise reduction.

A high value enables the filters to tolerate more variation among
neighboring frames that are used to synthesize the high-resolution frame
and reduce more noise. However, an excessively high value may also lead
to incorrect scene change detection and detail suppression.

A low value reduces the tolerance of variation, which may result in less
inter-frame information being used. Too small of a value results in purely
intra-frame interpolation, which will output a lower quality result. It will also
reduce less noise.

Tip: Use a high value, 8~15, when video is noisy. Use a lower value,
6~10, for clean videos.

Sharpness

This value specifies the strength of detail and sharpness enhancement.

Tip: increase this value to bring out more details.

Experienced users may further tweak the filter using the following parameters.
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Advanced Parameters of Enlarge*

Advanced Params

Description

Luma Noise
Reduction

0~1.0. A value of 0 disables noise reduction, which should be used for
high quality video footage. 1.0 enables strong noise reduction.

Temporal Processing

Set the balance between spatial (intra-frame) interpolation and temporal
(inter-frame) processing.

Enlarge* tracks object motion in the video and compensates the motion to
obtains its result. When it detects large change or fails to reliably track
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large motion, it fails back to frame interpolation. This value determines the
balance between spatial and temporal processing.

Tip: 0.5~0.8 usually works for most situations. If no jagged edges occur,
try using a higher value so that more processing is used.

Color Noise Filtering

0,1,2, or 3. Use this setting to filter out color noise. Default value is 1 for
small color filtering.

Height Adjustment

A value greater than 1.0 will make the output video taller.

Add Grain

This adds a small amount of grain to the resulting video. This sometimes
leads to a more natural-looking video. 0 will disable this.

If the video is interlaced, the following parameters can be used to adjust Enlarge*’s de-

interlacing.

Advanced Parameters of Enlarge*

Advanced Params

Description

Threshold

Specifies the threshold for change detection.

A high value enables the filters to tolerate more variation among
neighboring fields that are used to synthesize the high resolution.
However, an excessive value may lead to incorrect change detection and
jagged edges.

A low value reduces the tolerance of variation. Too low of a value may
result in intra-fields interpolation which will give a lower resolution result.

Tip: Use high values, 6~12, when videos are noisy. Use lower values,
4~8, for relatively clean videos.

Temporal Processing

Enlarge* tracks object motion in the video and compensates the motion to
obtains its result. When it detects large change or fails to reliably track
large motion, it fails back to frame interpolation. This value determines the
balance between spatial and temporal processing.

Tip: 0.5~0.8 usually works for most situations. If no jagged edges occur,
try using a higher value so that more processing is used.

Non-After Effects Hosts

For hosts other than After Effects, an extra parameter must be set correcily.
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Deinterlace* - Additional Parameters for non-AE hosts

Parameter

Description

1! Footage frame
rate

You must enter the exact frame rate of the footage.

For example, if the footage is a NTSC DV with 29.97 FPS, you must enter
29.97 (not 30 or 29.95) in order for Enlarge* to achieve optimal results.
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Remove Compression Artifacts

Jo ntscClips.avi -l\

DI # ntscClips.avi

= |f Remove Compression Artifacts Reset About...
» &) M Frame type + Interlaced
P & Suppression 25.0 %
= Advanced
» | YCbCr Subsample
+ &) Processing mode Vv slow /best quality

Remove Compression Artifacts is designed to remove fringes, blocks and other
artifacts caused by video compression. These artifacts appear as vertical and horizontal
lines in the video as well as fringes next to sharp edges.

Please be aware of the following to achieve the best result:

* The filter works for both interlaced and progressive videos. However, your
sequence or composition must always be progressive when using this filter even
if your footage is interlaced (After Effects users don’t have to worry about this).

This filter has two main parameters:

Remove Compression Artifacts - Main Parameters

Main Parameters Description

! Frame Type Make sure this parameter is set properly regarding the frame type
(interlaced or progressive) of your footage.

Suppression Sets the strength of artifact suppression.

Tip: an excessively high setting may cause the filter to mistake video
details for noise.

Experienced users may further tweak the filter using the following parameters.

Advanced Parameters of Denoise & Enhance*

Advanced Params Description
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CbCr subsampling

This refers to the color sub-sampling of Y:Cb:Cr in the original video
compression. Choose the choice that is nearest to your original: for
example, if you had 4:1:0, choose 4:1:1.

For example, use 4:1:1 for DV and 4:2:2 for MPEG2 or certain MUPEG
video files.

Processing mode

Checking the slow/best quality box will give you the better artifacts
reduction but will also make rendering each frame 2-3 times slower.
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Sharpen Edges (RGB)

Jo ntscClips.avi -!\

DI # ntscClips.avi

7 |f Sharpen Edges (RGB) Reset St
b & Radius 125
P &| Crispness 2.00
I &) Sharpness 1.25
= Advanced
b & Details 10,00
P &| G ch. Crispness Adj. 100
P &| G ch. Sharpness Adj. 100
P &| B ch. Crispness Adj. 1.00
> & B ch. Sharpness Adj. 1.00

Sharpen Edges (RGB) produces a sharper video by sharpening edges without
producing ringing or overshooting. It works directly on R, G, and B channels. It is
suitable for video material with no colorspace sub-sampling, i.e., 4:4:4 videos.

For videos with 4:2:

2 or 4:1:1 or others, you may find that Sharpen, Fix Color

Bleeding may produce a better result.

In addition, the filter works best with progressive videos. Use Deinterlace* on
interlaced videos first before applying Sharpen Edges (RGB).

The main paramete

rs of this filter are explained in the table below.

Sharpen Edges (RGB) - Main Parameters

Main Parameters

Description

Radius

Set the size and thickness of the edges to be enhanced.

Tip: use a smaller value (0.8~1.5) for relatively clean videos and use a
larger value (1.5 and up) for blurry videos.

Crispness

Sets the crispness of edges. Higher values produce sharp and hard
edges without ringing and overshooting. This value applies directly to the
R channel, and can be adjust for the G and B channels in Advanced.

Tip: an overly high value may result in unnatural results.

Sharpness

Sharpens the video similar to standard sharpening method. This value
applies directly to the R channel, and can be adjusted for G, B channel in
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Advanced.

Tip: May create overshooting when value is too high. Use together with
Crispness to get optimal results.

Experienced users may further tweak the filter using the following parameters.
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Advanced Parameters of Sharpen Edges*

Advanced Params

Description

Details

A higher setting allows more of the original frame detail to be shown.
However, it may also allow some original noise through as well.

G ch. Crispness Adj.

Sets G (green) channel crispness adjustment.

For example, if this value is 1.5 and Crispness is 2.0, the crispness value
for G channel is 3.5 (=1.5*2.0).

G ch. Sharpness Adj.

Set G (green) channel sharpness adjustment.

For example, if this value is 1.5 and Crispness is 2.0, the crispness value
for G channel is 3.5 (=1.5*2.0).

B ch. Crispness Adj.

Set B (blue) channel crispness adjustment.

For example, if this value is 1.5 and Crispness is 2.0, the crispness value
for B channel is 3.5 (=1.5*2.0).

B ch. Sharpness Adj.

Set B (blue) channel sharpness adjustment.

For example, if this value is 1.5 and Crispness is 2.0, the crispness value
for B channel is 3.5 (=1.5*2.0).
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JOntscClips.avi -l\

Filter Description

DI # ntscClips.avi

=¥ 3l Sharpen, Fix Color Bleeding

P &)Y Radius

P &/ Crispness

P & Sharpness

P &/ Color Bleeding Radius

= Advanced
P & Details
P &/ Color Bleeding Threshold
P &/ Color Prefilter Radius
B &/ Color Shift ¥
B &/ Color Shift ¥
+ Preview Mode

Final RGE o

Sharpen, Fix Color Bleeding enhances edges and corrects color bleeding. In the
luminance channel Y, it creates sharp and crispy edges without overshooting or noise
amplification. In the chrominance channels Cb and,Cr, it optimizes color edges and

reduces color bleeding.

This filter is suitable for processing analog NTSC/PAL/SECAM videos since they have
low color bandwidth. It is also good for processing digital video with 4:2:2 or 4:1:1
format, such as miniDV, MJPEG, MPEG, etc.

For 4:4:4 video or scanned film footage, Sharpen Edges (RGB) could be more suitable.

This filter also works best with progressive video. Use Deinterlace* for interlaced

videos before applying this filter.

The table below lists the main parameters of this filter.

Sharpen, Fix Color Bleeding - Main Parameters

Main Parameters

Description

Y Radius

Set the size and thickness of the edges to be enhanced for Y channel.

Tip: use a smaller value (0.8~1.5) for relatively clean videos and use a
larger value (1.5 and up) for blurry videos.
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Crispness Sets the crispness of edges. Higher values produce sharp and hard
edges without ringing and overshooting. This value applies directly to the
Y channel.
Tip: an overly high value may result in unnatural results.

Sharpness Sharpens the video similar to standard sharpening method. This value

applies directly to the Y channel.

Tip: May create overshooting when value is too high. Use together with
Crispness to get optimal results.

Color Bleeding
Radius

This value should be set proportionally to the amount of color bleeding in
the video.

Tips: zoom video to 200-400% to observe the color bleeding size and
processed result. Use Preview Mode to observe Cb and Cr channels.

Experienced users may further tweak the filter using the following parameters.
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Advanced Parameters of Sharpen, Fix Color Bleeding

Advanced Params

Description

Details

A higher setting will show more original frame detail. However, it may also
allow some original noise through as well.

Color Bleeding
Threshold

Any Cb or Cr edge below this value will be ignored. Useful for preventing
smaller UV features from being suppressed.

Color Pre-filter
Radius

The radius of a low-pass Gaussian filter applied to Cb and Cr channels
before color edge enhancement. Useful if color channels have extensive
noise and artifacts.

Color Shift X Shift colors a number of pixels to the right. To shift to the left, input a
negative number.
Tip: Some analog video may have color shift. Adjust this value to
compensate.

Color Shift Y

Shift colors a number of pixels down. To shift up, input a negative number.
These two parameters can be used to align color channel with Y channel.

Preview Mode

* Final RGB views your enhanced frame in RGB. What you see
here is what you get in export. You must use this mode when
rendering for final output.

* Processed YC displays YCbCr in place of RGB to observe the
processed result. The video will look different. You can use it to
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examine Cb or Cr channels (select G, or B channel to display) and
determine the effectiveness of color channel noise suppression.

Original YC displays the unprocessed frame in YCbCr format.
This allows you to compare the processed YCbCr with the
unprocessed YCbCr channels.
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Sharpen, Line Accent

Je ntscClips.ari -l\

DI * ntscClips.avi

- ¥ 3l Sharpen, Line Accent

P & Radius

P> &/ Line Accent

> &| Sharpness

P & Moise Threshold

= Advanced

> &/ Hor. Line Suppress 0.0

[ & Ver. Line Suppress 0.0

P & C Radius 2.00

P & C Sharpness 1.00
P &/ C Threshold

v &) Preview Mode Final RGB v

Sharpen, Line Accent sharpens video, reduces jagged edges, and enhances line
features. It can also suppress a small amount of noise.

The main parameters are listed in the table below.

Main Parameters of “Sharpen, Line Accent”*

Main Parameters

Description

Radius

Controls the size and thickness of edges.

In general, use a smaller value when you want to sharpen the picture and
use a greater value when you want to reduce video noise. When this value
is low, e.g. 1-2, sharpened edges are thin(1-2 pixels). However, only a
small amount of noise will be reduced. When this value is high, larger
amounts of noise will be reduced.

Line Accent

A higher setting will put an emphasis on line features in your video. Use a
high value to reduce jagged edges.

Tip: Apply this filter 2-4 times if one time is not enough to achieve what
you’re looking for.

Sharpness

Determines the degree of sharpness. A value greater than 1.0 will sharpen
the video while a value less than 1.0 will blur the video.

Tip: Be careful: this may cause overshooting when value is too high.
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Noise Threshold

Sets the threshold under which object edges will be treated as noise.

A high threshold suppresses more noise may also suppress details.

Experienced users may further tweak the filter using the following parameters.

Advanced Parameters of Denoise & Enhance*

Advanced Params

Description

Hor. Line Suppress

A higher setting will suppress strong horizontal edges in your frame.
Useful to reduce horizontal flickering effects

Ver. Line Suppress

A higher setting will suppress strong vertical edges in your frame. Useful to
reduce vertical flickering effects.

Color Radius

Sets the radius of the high-pass filter for U/V channel edge enhancement
and the low-pass filter for U/V noise reduction.

Color Sharpness

Determines how “hard” color edges are.

Color Threshold

Defines a threshold under which chrominance noise will be suppressed.

Preview Mode

Final RGB allows you to view your enhanced frame in RGB. What you see
here is what you get in export. You must use this mode when rendering
for final output.

Processed YC lets you display YCbCr in place of RGB to observe the
processed result. The video will look different. You can use it to examine
the Cb and Cr channels (select G or B channel to display) to determine the
effectiveness of color channel noise suppression.

Original YC displays the unprocessed frame in YCbCr format. Allows you
to compare the processed YCbCr with the unprocessed YCbCr channels.
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Jo ntscClips.ari -l\

Filter Description

Comp 1 * ntscClips.avi

b W avelet Filter

Animation Presets

P &/ Noise Threshold

P> & Sharpness

= Advanced
P &) Max Suppression
P & Threshold Hardness
b & Threshold Adj{R=45)
b & Threshold Adj{R=2.2)
P & Threshold Adj.{R=1.0)
b & Sharp Adj{R=4.5)
b & Sharp Adj{R=2.2)
b & Sharp Adj{R=1.0)
> &| R Threshold Adj.
> &| G Threshold Adj.
> &| B Threshold Adj.

>i4»

The Wavelet Filter uses a 3-scale wavelet filter for noise reduction, sharpness

enhancement, and edge correction. Basically, it filters edges at three different sizes, and

reduces noise and modifies edges individually in these three different sizes.

Wavelet Filter is an intra-frame filter that works on the current frame only. You can use
it together with Denoise & Enhance*, or Clean (RGB/YC)* to clean up the most noisy
video. In this case, apply Wavelet Filter first to videos and then Denoise & Enhance*

or Clean(RGB/YC)*.

The table below lists the main parameters of this filter.

Wavelet - Main Parameters

Main Parameters

Description

Noise Threshold Sets the overall threshold for noise suppression.

Tip: A high threshold can results in more noise suppression but may also
smooth out video detail. Sometimes it’s intentionally set to high to create
interesting artistic effects.

Sharpness Set the overall sharpness.
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Experienced users may further tweak the filter using the following parameters.

Advanced Parameters of Denoise & Enhance*

Advanced Params

Description

Max Suppression

Sets the maximum noise suppression. For example, if the value is 0.9, it
is possible to suppress up to 90% of noise if the Noise Threshold is set

properly.

Threshold Hardness

This value specifies the hardness of the transition around the Noise
Threshold.

Tip: a larger value tends to produce cleaner videos, but large noise may
manifest as artifacts.

Threshold Adij.
(R=4.5)

Adjust the noise threshold for edge components around 4.5 pixels in size.

Threshold Adij.
(R=2.2)

Adjust the noise threshold for edge components around 2.2 pixels in size.

Threshold Adij.
(R=1.0)

Adjust the noise threshold for edge components around 1.0 pixels in size.

Sharp Adj. (R=4.5)

Adjust the sharpness of edge components around 4.5 pixels in size.

Sharp Adj. (R=2.2)

Adjust the sharpness of edge components around 2.2 pixels in size.

Sharp Adj. (R=1.0)

Adjust the sharpness of edge components around 1.0 pixels in size.
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4

MORE INFORMATION

Our website is the primary resource:

* http://www.topazlabs.com/ has tutorials, tips, example projects and other resources to
assist you. If you have a problem, somebody may have an answer already. Please check
the site often.

e Twitter: http://twitter.com/topazlabs

e Email: support@topazlabs.com

We really appreciate your questions, suggestions, and comments. Don’t hesitate to email us!
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